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Install the bundled software programs,
and download images to the computer.

¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

¢ You may download images without installing this software.
However, there are several limitations (p. 77).
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use
of the products and to prevent injuries to yourself or other persons, or damage to property.
Please read and ensure that you understand them before proceeding to other sections of the
guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer hearing loss from listening with headphones to the
loud sounds of a CD-ROM played on a music CD player.

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the memory cards,
personal computers, peripheral devices, or use of non-Canon memory cards.

Canon Customer Support

For Canon Customer Support contacts, please see the customer support list supplied with your
camera.
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Using the PDF Manuals

The following PDF manuals are provided to explain the features and procedures
for using ZoomBrowser EX and ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

¢ ImageBrowser Software User Guide (Macintosh)

manuals.

Iﬁl Adobe Reader must be installed to read the aforementioned

These manuals are available on the Canon website.
Use your browser program to download these manuals from the following URL:
http://web.canon.jp/imaging/information-e.html




This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide

¢ The explanations in this guide are based on Windows XP and Mac OS X v10.4. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.

¢ The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.4-v10.5)

Precautions

Precautions for Connecting the Camera to the Computer

¢ The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.

* The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

* Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

¢ Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.

*You are recommended to use an AC adapter (sold separately) when
connecting to a computer. Ensure that you use fully charged batteries if you
cannot use an AC adapter.

*See the Camera User Guide for procedures connecting the camera to the
computer.
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It's so Simple! Make Prints Right at Home
Like a Pro

~— Shoot the images

=
See your Camera User Guide for
shooting instructions.
A
y
. vy
v
~ Install the software on the computer 1
Just install the software once at the
@ beginning.
Windows (p. 11)
Macintosh (p. 43)
. vy
v
~— Connect the camera to the computer \

See your Camera User Guide for
connecting instructions.

Precautions for Connecting the

Camera to the Computer (p. 3) )

G
. v
~— Download images to the computer 1
Windows (p. 15)
Macintosh (p. 45)
y
~
- Windows (p. 20)
Macintosh (p. 49)
G 4
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Unbounded Possibilities with Entertaining
Software

ZLoomBrowser EX (Windows)/ImageBrowser (Macintosh)

Versatile image management software for downloading images, editing still images and
movies, and printing.

Experiment with diverse printing techniques

Print a variety of layouts. Change paper sizes and print your photos with date stamps and
comments to enjoy an expanded range of possibilities.
Windows (p. 20)  Macintosh (p. 49)

Printing images is easy
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Print comments on your E E %gm

postcards and invitations

Print date
stamps with
your photos

Check multiple photos at
a glance with index
printing.

Edit a Movie

You can remove unwanted sections at the beginning or end of a movie. You can also use the
memory card reader to upload the edited movie to the camera.
Windows (p. 26)  Macintosh (p. 55)

Extract Stills from Movies

You can extract a still from the displayed movie and save it as a new image file.
Windows (p. 26) Macintosh (p. 55)
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Operate the Camera Shutter from the Computer (Remote Shooting)

Shoot and control the camera’s shutter from a computer. You can save the recorded images
directly to the computer. (Certain models only)
Windows (p. 32)  Macintosh (p. 61)

Enjoy Customizing Your Camera (My Camera)

Set your favorite images and sounds as the camera’s start-up image or shutter sound. (Certain
models only)
Windows (p. 39) Macintosh (p. 68)
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PhotoStitch (Windows/Macintosh)

A program for merging multiple images into dramatic panoramas.

Stitch a Panorama Together
Windows (p. 35)  Macintosh (p. 64)
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System Requirements

Please install the software on a computer meeting the following minimum requirements.

0s

Windows Vista (including Service Pack 1)
Windows XP Service Pack 2

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU Still Windows Vista: Pentium 1.3 GHz or higher
Images | Windows XP: Pentium 500 MHz or higher
Movies | Core 2 Duo 1.66 GHz or higher

RAM Still Windows Vista: 512 MB or more
Images | Windows XP: 256 MB or more
Movies | 1 GB or more

Interface usB

Free Hard Disk
Space

¢ Canon Utilities
- ZoomBrowser EX:
- PhotoStitch:
- Digital Photo Professional

200 MB or more

40 MB or more

200 MB or more
(certain models only)

Display

1,024 x 768 pixels/High Color (16 bit) or better

(0

Mac OS X (v10.4-v10.5)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU Still PowerPC G4/G5 or Intel Processor
Images
Movies | Core Duo 1.66 GHz or higher

RAM Still Mac OS X v10.5: 512 MB or more
Images | Mac OS Xv10.4: 256 MB or more
Movies | 1 GB or more

Interface uUsB

Free Hard Disk e Canon Utilities

Space - ImageBrowser: 300 MB or more

- PhotoStitch: 50 MB or more

200 MB or more
(certain models only)

- Digital Photo Professional

Display

1,024 x 768 pixels/32,000 Colors or better
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If you will be using Digital Photo Professional, check the “Processing Raw Images” section also
(Windows, p. 36; Macintosh, p. 65) (certain models only).

0 ¢ A CD-ROM drive is required to install the software.
¢ Even when system requirements are met, not all computer functions can be
guaranteed.
¢ A sound card is required to play movie file audio tracks in Windows.
¢ With Windows, Microsoft .NET Framework 2.0 or later is required.
¢ Macintosh software can only be used on disks formatted in the Mac OS
Extended (journaled) format.

Previous ZoomBrowser EX/ImageBrowser Versions

eIf you are already using a prior version, use the supplied CD-ROM (Canon
Digital Camera Solution Disk) to install and overwrite it with the new
version.

eIf you were using ZoomBrowser EX Ver. 2 or 3, perform the following
procedures after installing the software.

1. Double-click [dbconverter.exe] to start it.
Example: C:\Program Files\Canon\ZoomBrowser EX\Program Folder\dbconverter.exe

2. Select the database file used up to now and click the [Start] button.
Example: C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd

If images were saved in the Program Files folder, then continue with the
following procedure.

3. Copy the image folders in the Program Files folder to the [My Pictures]
folder.
Example: C:\Program Files\Canon\ZoomBrowser EX\Library (1)




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

e Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.
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3 Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the [User Account Control] window appears, follow the
on-screen instructions to proceed.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

1. Select [Computer] or [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

. Y .
3. Double-click the [SETUPEXE]* s icon.
4. When [User Account Control] window displays, follow the on-screen instructions to
proceed.

* Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software [Easy
Installation] button. Sanos DIGITAL CAMERA

To individually select the software to install, Solution Disk
click [Custom Installation].

Digital g

" Easy Installation
(_taay nstalistion

Installer Panel

5 it other software is running, close each
program before clicking [OK].

Start installing Digital Camera Solution Disk.
Close any other open applications and dlick [OK].
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6 Review the installation settings and

P ]
click [Install]. e
— F e
= g o o
sep3  instalianon w 06 Utity e
stop  Frich
The items in the list may differ from those
illustrated depending on the software [T
installed on your computer. J
Installation folder Available space: 22447 M
CAProgram FlesiCareh,
Chek [Instat] to staet mtaltng. o
S
7 Click [Yes] if you agree to all of the
terms of the software license e
agreement. — N :
The installation will start. wade., ?ﬁfwwﬁ SR
) ) > - ey
Follow the on-screen instructions to O N L
proceed with the installation. ;;;ﬁwﬂwggxm“ﬁﬁm
Click [Yes] if a dialog confirming the N
installation of Microsoft .Net Framework o e
displays. "
s
8 When the installation is over, select
[Restart computer immediately
(Recommended)] and click [Restart]. N Wy G a———
At this stage, do NOT remove the Solution ; I —
Disk from the CD-ROM drive yet. et
Finish

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive to conclude the installation.
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© Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Iﬁl See Uninstalling the Software (p. 71) to delete the installed programs.

To ensure security on computers with Microsoft .NET Framework

installed, it will be necessary to update the computer using Windows
Update.

You may now download camera images to the computer (p. 15).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Windows Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 18).

Camera to Computer Connection

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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2 Select [Canon CameraWindow]
when a dialog (Events dialog)
similar to that on the right
displays and click [OK]. (e EEsiEd

In Windows Vista, select [Downloads

Canon XCCCOOOOOOCKKK

. Select the program to launch for this action:
Images From Canon Camera using 7
Canon CameraWindow] from the <
AutoPlay dialog. NS
i Canon EOS Utility
ifp.l-“"' Diownloads images from EOS camera
Your camera model name or —— 0o #

[Canon Camera] will appear here. ; Microzoft Scanner and Camnera Wizard

Download pictures from a camera or scanner

Different programs may display
depending on your computer setup.

[ &lwaps use this program for this action

< L Ok J D Cancel

If this Events dialog does not appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[CameraWindow] and [CameraWindow].

CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

CameraWindow

6122008
. f.'ae,. I
ol -
| Cawow Umiumies
CameraWindow DC

Operate using the camera

Push the camera buttons.

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window

3 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] or [My Pictures] folder.



17

Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

*\When it is possible to use the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Dhan
(Print/Share) button will light blue.

* See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the $has (Print/Share)
button or the FUNC./SET button.

Direct Transfer
G ALl Images.

The &yar (Print/Share) button will blink

. L i New
blue during the transfer and remain lit DROF e M icc=h
when it is complete. Click the mouse =+ Select & Transfer..
button or press any key on the keyboard to EJ Wallpaper..

resume the ability to operate from the
computer.

Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow

&ameraWindow DC

‘*i‘ﬁ Operate using the camera
7‘ Push the camera buttons.

Transfer Untransferred Images

Click this buttonto ——o——— Operate Images on Camera
close the start screen.

Thumbnail Window View Window

¢ To download images that have had transfer settings set with the
camera, use the camera or a memory card reader.
*To check images in the camera or to download only a portion of the
images, click [Operate Images on Cameral.

®
®You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.
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When you click [OK] in the image transfer completion window, the transferred images will

display in the Main Window.

The downloaded images are saved into folders according to the shooting date.

The last downloaded images
will display here according
to both their shooting dates
and categories.

e -

(]

IMG_0002 PG

H IMG_0001 6

== =

Folders Area
The downloaded symbol
displays on downloaded
folders.

IMG_0007 G

60005 PG IMG_006 PG

Thumbnail

Next, print out the images (p. 20).

Memory Card Reader Connection

2

Insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

Select [View/Download Images using

Canon ZoomBrowser EX] when the

dialog to the right appears and click

[OK].

[ &hways do the selected act
[ Ok ] ) Cancel
i —

5

proceed to Step 3.

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [ZoomBrowser EX
Memory Card Utility], [ZoomBrowser EX Memory Card Utility], and
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3 Click [Download Images].

ZoomBrowser EX Canon

1
E
@

You can adjust the settings, such as Lets youselectand |
the type of image downloaded and e

the destination folder, by clicking { Print Menu |
[Preferences]. LTSRS

e

Preferences... Exit I

¢ By default, all the images that have yet to be downloaded will
download to the [Pictures] or [My Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

e See Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date and category in the [Last Acquired
Images] section.

Next, print out the images (p. 20).
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Printing Images

There are three methods for using ZoomBrowser EX to print images: [Photo Print], [Index Print]
and [Print Using Other Software]. This section explains how to use the [Photo Print] option.

¢ Movies cannot be printed, but you can print still images saved from movies.

*To use the Index Print option, click [Print & Email] in the Main Window,
followed by [Index Print].

Prints one image on each page.

1 dik [Print & Email] in ZoomBrowser EX's Main Window, followed by [Photo
Print].

T ZoumBroveser EX - Al Images

Fle E@ Viow Took bkemet hep

Tosks )

8] acqie & Camens Setings

Tasks

ZoomMode | Serol Mads | F LB icopas e Conms Soltrge.

Zocm o | St o | P
imaged

I vews ity Ao
=L ta
e —
——
T

Last ccired Images [7)

W Aoy

5 ] SeotimDare
] 20080512
) 2on 0613

2 After confirming that [1. Select Images] is selected, select images.

You can select multiple images by holding the [Ctrl] key down while clicking on successive
images.

F ZoomBrowses X - All napss

The background of
R selected images

S e s e changes to blue.
EET—

Seechod T 3
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3 dlick [2. Printer and Layout Settings] and adjust the categories as you feel
necessary.

Text can be inserted here to print
with this photo.

ot Satings and Fresies.

@ Remoue umwanled
rexjions ofyour phetc

Tom mage Insan Teod

Ackd or Modty e 1o
e et i phon

Selects the printer
and the paper size
etc.

Selects a printing
method for the
shooting date/time
information.

Sets the number
-|- of print copies.

This button switches between images if
multiple images were selected.

4 Click [3. Print].
Printing will start.

This chapter explained the ZoomBrowser EX basics.
Once you have mastered them, try the advanced techniques.

e Using the Software on the Windows Platform — Advanced Techniques (p. 22).



This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer

Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Buttons (p. 23)

Fin E view Toob Fieme] Hep

Function Buttons (p. 25)

7.

(23] Acpie  CaraBetirs Pem—

e

P bode )

I verscmar 2008 0512
=L o
i e
%] PonttEnal

Last Acqured Images

Favorle Foldess | 41 Fouders |

Q@00 R-0-

L3

Y

=y

3) z0an_oe,
'3 z008_06_13
) SearthResuts

Sebectnd lhems: O

Folders Area (p. 23)

Last Acquired Images (p. 23)

Display Mode
(p. 24)

Display Control
Panel (p. 25)

Browser Area
(p- 23)

Switches between
showing and
hiding the Task
Buttons and Last
Acquired Images
section and the
Folders Area.
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Task Buttons

e ZoomBrowser EX's tasks are arranged here like an index.
* Click a Task button to carry out the desired task.
These features are described in ZoomBrowser EX Features (p. 28)

Folders Area

¢ Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

¢ If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

e If [Favorite Folders] is displayed: click [Add] and select a folder.

o If [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Last Acquired Images
*You can check images grouped according to the shooting date or My Category.

Browser Area

¢ The folders and the images within the folders selected in the Last Acquired Images section or
Folders Area display here. The display style will vary according to your Display Mode selection.

*You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by selecting [View] and [Sort by].

¢ The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode

m RAW images
E Movies

Images with sound memo attachments

a Protected images

Images shot with the camera's AEB function
Rotated Images (In display only)
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Display Mode

e Selects the display style for the Browser Area.

Zoom Mode

Displays all the images in a folder as thumbnail
images. This mode is convenient for searching
for images since many can be displayed at
once.

If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.

If you move the mouse cursor over a folder,
== will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

The images within the selected folder and
subfolders will display. If you set the display
folder depth (level) to [1] or greater, the
thumbnails of the images in the folder will also
display. You can change the folder depth in the
[Tools] menu under the [Preferences] option.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

In zoom mode or scroll mode, positioning the mouse pointer over a
thumbnail causes the image to appear at a higher magnification in a Mouse
Over window. You can also set the Mouse Over window to not show in the
@ - (Show Information) menu.




Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Fit to Window
Changes the thumbnail size to
fit them into the window.

—

i + i H ']
| = = HDK

Selection Menu
Click this to select/deselect all
images in the Browser Area.

Q00 =R-0-[k

25

Display Size
Changes the size of the
thumbnail in the Browser Area.

| o | F Fiter -

Show/Hide Image Information Menu
Select here to show/hide such image
information as the file name or

Filter Tool Menu J

Displays only images that
correspond to the specific

shooting date or rating beneath the
thumbnail.

Select Button
Use this to select images
in Zoom mode.

Function Buttons
¢ These buttons are available for executing various functions.

View Image Button Slide Show Button
Displays the selected image Starts a slide show of the
or movie in the Viewer selected images.

Window. |

,_rj View Image

Properties Button Search Button
Displays information about
the selected image in the

Properties Window. Star Rating,

= [ = &
Propetties grlg sSlide Show { Search "J Delete If }| R.otate

Searches for images
using such criteria as the

conditions.

Rotate Button
Rotates the selected
image.

\_‘

\_‘

Delete Button
Deletes selected
images or folders.

modification date,

shooting date,

comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu
You can edit, eliminating red eyes,
adjusting colors and brightness,
cropping and inputting titles. You can

also use it to start up other programs Shooting .

for editing. P pros Information Synchronize Button
Display Button Synchronlzgs the

Print Button Displays image d'SFI)I_aYI settings when

Prints the displayed image. shooting dm:l T;F’ :dlmages are
information. Isplayed.

= ZoomBrowser EX - C:\Docume its and Settingsboodéy documents\y Picturesi2008_06_10unG 000 .06 [ [[E1)(%)
Fle Edi View Help

D0 8 Lo 2= (T TI0T

Number of
Displays
Button
Displays
multiple
images at
once. This is
handy for
comparing
images.

= — b B 7 )M weafn
Image Selector I

Button

Switches between
images.

Sets the image  —
display size to the
size in the Viewer
Window.

Displays images in —
the Viewer

Window at their
actual size.

| Zocm Ruatios #]

Zoom Star Rating
Changes the image Sets the Star Rating for an image.
zoom setting.

Full Screen Button
Displays the image in the full screen mode. Click the image or
press any key on the keyboard to restore the normal display mode.

*RAW Image is Displayed
The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed
eButtons will appear beneath the movie, allowing it to be played or the
sound to be adjusted.
*On some computer systems, you may experience dropped frames leading to
jerky motion or intermittent sound when replaying movies.
*You can extract still images from movies by clicking the [Save as still image] button,
which appears beside the Star Ratings buttons. You can also delete unwanted
sections at the beginning or end of movies by clicking the [Cut Movie] button.
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The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categories. X
Modified. BA12/2008
File Size: ATOE KB
Image Size: 1600 % 1200
Drata Type: JPG
S ——1— Plays a sound memo attached
to an image.
Path C:ADocuments and S ettingshwedMy Docume Protect
rotec
%] FileN : :
. ,D bk Prevents an image from being
File Name d1kG_ooo1 |

overwritten or deleted.

The file name

Star Rating and My Categany:
can be changed. ]

AL AL 1aE

Star Rating and Comment:
My Category inKamakura
Sets the rating
for an image.

Comment
You can type a comment here.

Kepwords:

A icon witl [ evtiedierors . ——————1— Keywords
Isplay it a My iy = Sets the keywords used in
Category is set. Brightness Histogram:

searches.
A graph of the highlights and

S shadows distribution in an
ern Nznr::g nnrmanm\v’alue ] image-

f - Filz Name IMG_0001.JPG 3

ShOOtlng Informatlon Camera Model Mame  Canon <4< F
i i Shooting Date/Time  6/12/2008 315:22 AM

F)I:playst(.ietaHEdh th Shooting Mode Auta
Intformation, such as e Tv [Shutter Speed] 14250
Shutter Speed and A_v [Apertur_e Walue] 71 . Fe
€Xposure Compensatlon < Previous Hest > — Image Selector Buttons

setting. The camera model
will determine what
information is displayed.

If multiple images are selected
with the Properties Window
displayed, you can switch
between the images for which
the information is displayed.
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ZLoomBrowser EX Features

This section briefly introduces the ZoomBrowser EX features.

Some ZoomBrowser EX functions may not be available with certain camera
models. Check the Specifications section of your Camera User Guide to see if
your model supports them.

The following workflow is used in ZoomBrowser EX.

1 dlick a Task button.

Check the Help menu for
procedures and features.

(18] noqiel Caness sonvis

(J e ety
= ea
Task Buttons — 5o

5 Pt nst

B |

Indes Pt

The Task buttons are explained in “Task Button Functions” (p. 29).

2 Pperform the procedures according to the instructions.

Summary of the
procedures for this step

s
0 e

T| etvormoyms
it i .
Tomimaga nser Tet

Steps to follow

Procedural instructions

Return to Main Menu

Eriren]
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Task Button Functions

Acquire & Camera Settings ‘

Connect to Camera @ Acquire & Camera Settings

You can do the following when you connect
the camera and display CameraWindow.

GEl Acquire Images
=Y Downloads images and sound files from the camera (p. 15).

Print Images

=3 Selects and prints the images in the camera.

G} Write to Camera

=Y Uploads images on the computer to the camera.

@) Set to Camera
3@ Sets the camera owner’s name.

Connect to EOS Camera

This can only be used with EOS series cameras. For details on this function, see the user guide
for your camera. (Windows XP only)

Acquire Images from Memory Card
Downloads images and sound files from a memory card (p. 18).
You can also select images on the memory card and print them.

Transfer Images to Memory Card
Uploads images from the computer to a memory card.

View & Classify =

T i
View as a Slide Show :HU Sz By
Starts a slide show of the images selected in the
Browser Area.
Rename Multiple Files
Changes the file names of the selected images in a single pass.
Classify into Folder
Classifies images and saves them into a specified folder.
Search
Performs image searches using criteria such as the Star Rating, modification date, shooting

date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.
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Edit 2o
Edit Image ‘ o Bt
Allows you to perform image editing, such as

cropping, image correction, inserting comments, and red-eye correction. You can also use it
to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 35).

Digital Photo Professional - Process RAW Images (certain models only)
Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 36).

Export

Export Still Images i=p’ Export
Allows you to change the image size or type,
and export it as a new image.

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.
¢ CD-R/RW capable drive supplied as standard equipment
* CD-R/RW writing capabilities are operating correctly
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Print & Email = ‘

= . N
Photo Print """"«...—vj B
Prints one image per page (p. 20).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Email Images

Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

ZoomBrowser EX has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 39).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 32).
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

0 e Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 Click [Cancel] (B8 in Windows Vista) to close the Events Dialog (or the slide
show screen) if it appears.

If CameraWindow appears, click [Operate Images on Camera] followed by E3 in the View
Window to close CameraWindow.

CameraWindow

| canon umumes

CameraWindow DC

. f,‘_a[ —i;l Operate using the camera

Push the camera buttons.

Transfer Untransferred Images

Operate Images on Camera

Thumbnail Window View Window
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In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [RemoteCapture DC 3] and [RemoteCapture DC].

According to the default settings, recorded images are saved into the
[Pictures] or [My Pictures] folder. To change the destination, open the
[File] menu in the remote shooting window and select [Preferences].

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Shows/Hides the Size and Resolution Selector
viewfinder or detailed Selects the size and resolution at which images are captured.
settings area.

Rotation Settings

™ RemoteCapturaTask : : [ Sets the rotation
File(F) Camera() Shooting(S) Help(H) paramete rs for
(©) Hide viewFincer G images after they are
(©) Hide shoating detaits = . captured.
& F 4 |,
You can add =t add comments shown below
comments to images |/ Release Button

Releases the
shutter.

by placing a check
mark here and

typing text in the
boxes below. Slide this to zoom

the camera in or out.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Field angleiflash Shocting seftings

Flash

displayithe_image | =l Jorr -l Refresh Button

appearing in the Magro: iy Resets the exposure,

camera’s viewfinder. Jort =1 — || focus and white
Agr—‘asswst light: - balance.

AF operstion
AF unlock

Set the basic camera settings here.

Iﬁl The settings available vary between camera models.
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

1 cdik [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].
2 Click [1. Select Images] and select several images in the Browser Area.
3 click [2. Open PhotoStitch].

Instructions

‘ STA_O578.FG | STE.OS79.PG ‘ STC_0580PG | STD_0581.PG

po_of inagm: 3

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images a = =
shot in Stitch Assist mode. = :

* Some camera models may not support Stitch Assist mode.

¢ See the Camera User Guide for information about shooting in Stitch Assist mode.

*Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

*Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

*The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

*You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 ik [Edit] in ZoomBrowser EX’s Main Window, followed by [Digital Photo
Professional Process RAW Images].

2 seclect a RAW image in Digital Photo Professional’s Main Window.

3 click =3 (Edit image window).

Main Window

Selects folders —
containing
images.
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4 Adjust the image brightness and white balance in the tool palette.
The modified contents (the information for image processing requirements) are saved

along with the image as a “recipe”.
The items available to be modified differ depending on the camera model.

You can adjust all three RGB
channel levels together or
separately with the Tone Curve. ‘ Reduces noise that occurs

when shooting night time
scenery, or when shooting
at a high ISO speed.

Adjusts the brightness,
white balance and picture
style.

Adjusts the contrast, color
tone, colorsaturation and
sharpness.

Tool Palette

Hahguaty a1 3hue

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 In the [File] menu, select [Convert and save], set the file type and destination and
then click [Save].

Selects the file ——————— swn [Qwroue: foscm

destination. D B
E.nanrv‘l- ity Pctures
@
Do
Vet
Renames the file. 9
| Lo
e Fiz IMG_001LPG v Sae
Ii— Sare ¢ pe El JPEG[ JPG," JPEE) v Cancel
Selects the file type. ououtssting

ouputresohgon | 380 | gpi ElEmued (CC profi i rrage

Rosts s

e Insert a check
mark here to
change the file
size.
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

I— Inserts text.

REXIKXKKKXKARNA

10 |my {925 mm

a Heiont
2030 e {1383 rm

W ﬂ ﬂ Sets the image size and

image layout, and
g g shooting information.

mans

] Comer registration marks

[ Cerdor registration marks:

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

I_# Inserts text.

Frintar | Image | Tewd | Saltnns
Lavout.
Number of mages
Coumne
3 gam

Sets the number and order
ER ) of images laid out on one
Lot sheet.

Covarcal

Rows

@ Horzontst

[Pt Ccaneai ) [ apey_)
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Enjoy Customizing Your Camera with the My
Camera Settings

My Camera functions are only available with camera models listed as
compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you

install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

er connecting the supplied interface cable to the computer’s port and the

1 Aft ting th lied interf ble to th ter's USB port and th
camera'’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Methods for connecting the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 Click [Cancel] (B3 in Windows Vista) to close the Events Dialog if it appears.

If CameraWindow appears, click [Operate Images on Camera] followed by E3 in the View
Window to close CameraWindow.

CameraWindow

"’ il > mil
s

CameraWindow DC

Thumbnail Window View Window
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3 In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.

4 Click [Connect to cameral. EST%é
The My Camera window showing HORSERALZ!
images in the camera will display. KAgUKIvO21 -

Connect to camera |

Clase

5 selectthe [Setup as a theme] tab.
To set the start-up image or sound individually, select the [Set individually] tab.

6 sclect the settings to add and replace.

Settings to add: select from the [My Computer] list.
Settings to replace: Select from the [Camera] list.

7 cClick [Save to Cameral]
Clicking [OK] overwrites the settings previously registered on the camera.

My Camera 3]
Setup s o theme St ribvduahy |
Sauct My Camara D3 11ps 3 5 vl
Dals Type:

Starten Image: -

My Compuer Comera

2 321_sion

Displays the
settings saved to
the computer.

[Save to PC] Button
Saves settings files
[Delete] Button registered with the
Deletes settings e camera to the

from the computer. computer.

8 Changing the My Camera settings with the camera.
See the Camera Users Guide.
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Creating Original Start-Up Images or Sounds

You can use My Camera Maker to effortlessly create image files or sound files for use as start-
up images or start-up sounds.

1 In the [Start] menu, select [All Programs] or [Programs], followed by [Canon
Utilities], [CameraWindow], [MyCamera] and [MyCameral.
The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.

My Camera Maker will start.

My Camera rz‘

Select My Camera Data type and set individually

Data Type:

|Slutwlmage[lur common cameras) Ll
My Computer:

-~ Startup Sound
321_SI0.JPG 1

ANIMALO22 S107.JPG Shutter Sound
ANIMALO23_S101.JPG

BAR21_SI01JPG Operation Sound
BASEBALL21_SI01.JPG

CHIMPANZ1_SI01.JPG Selftimer 5 ound
ETHDANCE21_SI0NJPG
ETHTECHN21_SI01.JPG
FUN21_SI0JPG
FUN22_SI01.JPG
FUN23_SI01.JPG
FUN24_SI01.JPG
GAKKI21_SI01 JPG

Add File Button BAME SI0TIEE
Adds images and sound files for use SOLEA S IFE
as settings files in the list. HORSERAC2. SION.JPG

IYASHIZI_SIOTJPG
KABUKIYD21_SI01.JFG
KIKDRIZI SI0T.JPG

addFie.. [ Creale My Camera data

Delete Connect to camera I

Close

3 Follow the instructions at the top part of the My Camera Maker window and
create image or sound files.
The created settings files automatically appear in the My Camera window.

Add the files to the camera following the procedures in Adding My Camera Settings to
the Camera (p. 39).
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Gl

Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images
Image Type
Data Sampling
Resolution (WxH)

e Start-Up Sounds

Type
Bit Rate / Frequency

: JPEG (Baseline JPEG)
:4:2:0 or 4:2:2
1320 x 240 or 512 x 288*

* Varies with camera model

: WAV (Monaural)
: 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the

following chart.

Duration in Seconds

Type 11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to install the software. Read this before connecting the camera to
the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

ltems to Prepare

e Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

N =t

&y
Qu) in the CD-ROM window.

4 Click the Digital Camera Software [Install] button.

il DIGITAL CAMERA
Solution Disk

Digital Camera Sofware

==
o

Installer Panel
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5 Select [Easy Installation] and click
[Next].
Select [Custom Installation] to select
programs individually for installation.

6 cik [Agree] if you agree to all of the O, o comred & ganed oy Caan o o I il ppery fcaen g o wanso o
terms of the software license
agreement.

7 Review the installation settings and
click [Next].
Follow the on-screen instructions to
proceed with the installation.

8 When the installation is over, click
[Finish].

Installed
Installed

9 Click [Exit] in the installer panel and remove the disk
from the CD-ROM drive.

This concludes the software installation.

See Uninstalling the Software (p. 71) to delete the software installed
with these procedures.

Continue by downloading images to the computer (p. 45).



This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Proceed to this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different depending on whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).

Camera to Computer Connection

1 After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.
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CameraWindow displays when the camera and computer are set to the mode to
communicate. (Images are not downloaded at this point.)

v DC

CameraWindow - Caron il Comeriion D - 1, 0007
= -
OEE22

1 the camera

e Transfer Untransferred Images

Operate Images on Camera

2 Disol

Thumbnail Window View Window

If CameraWindow does not open, click the [CameraWindow] icon in the
Dock (the bar at the bottom of the desktop).

2 Download the images using the camera or the computer.
By default, the downloaded images are saved into the [Pictures] folder.

Using the Camera to Download Images
Download images using the camera’s Direct Transfer function.

¢ If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear on the LCD monitor and the Thar
(Print/Share) button will light blue.

*See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the $has (Print/Share)
button or the FUNC./SET button.

Direct Transfer

G A1l Images..

The ‘Q“‘\.’ (Print/Share) button Willlblilnk
blue during the transfer and remain lit [%= DPOF Trans. Images.
when it is complete. Click the mouse = Select & Transfer..
button or press any key on the keyboard to E5 Wallpaper.,

resume the ability to operate from the
computer.
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Using the Computer to Download Images
Click [Transfer Untransferred Images].

CameraWindow

Click this button to
close the start screen.

Thumbnail Window View Window

¢ To download images that have had transfer settings set with the
camera, use the camera or a memory card reader (p. 48).

*To check images in the camera or to download only a portion of the
images, click [Operate Images on Camera].

e You can also click in the View Window to upload to the camera still
images that were downloaded to the computer.

When you click [OK] in the image transfer completion window, the transferred images will
display in the Main Window.

The downloaded images are saved into folders according to the shooting date.

The last downloaded images
will display here according
to both their shooting dates
and categories.

Folders Area
The downloaded symbol
displays on downloaded
folders.

Thumbnail

Next, print out the images (p. 49).
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Memory Card Reader Connection

T  insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the
reader.

2 click [Download Images].

ImageBrowser Canon

Lets you select and
‘ download images

You can adjust the settings, such
as the type of image downloaded
and the destination folder, by ¢ ‘ F— ‘
clicking [Preferences]. & 2 Z—— :

| L
[ — -

If the window above does not open, click the [CameraWindow] icon in the Dock (the bar
at the bottom of the desktop).

Preferences... Exit

* By the default settings, all images are downloaded to the [Pictures]
folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

¢ Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

*See Memory Card Folder Structure (p. 72) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

At the same time they will also appear grouped by date or My Category in the [Last
Acquired Images] section.

Next, print out the images (p. 49).
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Printing Images

There are three methods for using ImageBrowser to print images: [Photo Print], [Index Print]
and [Layout Print]. This section explains how to use the [Photo Print] option.

Iﬁl Movies cannot be printed, but you can print still images saved from movies.

Prints one image on each page.

1 select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple

images, hold down the [shift] or [ §§ ] (command) key while clicking on images.

4 Brovwsar Wisidow

6.0
2008.06.10
2008 06,11

2008 05 12
Laz08 0513
i Phora Library

A blue frame
displays around
selected images.

2 Click [Print & Email] and select [Photo
Print]. &

show

& email Send to Tras|

g Photo Print... btes®) Total: 5 images 4

Layout Print...
Create Image for Email...

Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.

Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.
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3 setthe categories as you feel necessary.

ens Photo Print

printer

Selects a printer. 100000001 5]

Selects options such as the paper size —l i

"
and orientation when you click AT
[Page Setupl. e

| Shooting Data/Time

Selects a printing method for the ——— | o »
shooting date/time information. e

Bl P L vt

| 4P| imge: 173 Copes: 1B Towal:  3pages

A |

Click this button to switch  Sets the
between images if you number of
selected multiple images.  copies printed.

Text can be inserted here to —
print with this photo.

4 Click [Print].
The Print window will now open.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click [Close] to close the window.

This chapter explained the ImageBrowser basics.
Once you have mastered them, try the advanced techniques.

e Using the Software on the Macintosh Platform — Advanced Techniques (p. 51).



This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

Browser Window

This window is for displaying and organizing images downloaded to the computer.

Last Acquired Display Mode Browser Area
Images (p. 52) (p- 53) (p. 52)

st dpeived R
wigliShaw All Images
widShooting Date e - -
92008 06_12 File Mame:

2008_06_13 Modified:
villMy Category | F File Size:
People ) . Image Size:
Miscunary i Duta Type:
M vents —
Al Folders e =
L Movies.
i Pitures W Sta Rating 1 My Category
»{ 2005_06_08 (Eee
[ 2008_06_09
[ 2008.06.10
[z008.06.11
[#2008_06_12
[ #2008.06.13

»{diPhato Library

& = ]

-
5 Viewmage  SlideShow P & Emad semmmm)

W
|

el Gt 1] Yo T

Folders Area (p. 52) Control Panel (p. 54) Display Control Panel (p. 54)
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Folders Area

¢ Use this area to select folders. The selected folders and the images within the selected folders
display in the Browser Area.

¢ If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o If [Favorite Folders] is displayed: click [Add] and select a folder.
o If [All Folders] is displayed: select a folder and click [Add to Favorites].

Last Acquired Images
¢ You can check images grouped according to the shooting date or My Category.

Browser Area

¢ The folders and the images within the folders selected in the Last Acquired Images section or
Folders Area display here.
The display style will vary according to your Display Mode selection.

* The following types of icon will display around images according to their attributes.

™ Images shot with the camera's Stitch Assist mode

RAW images

- Movies

FJH Images with sound memo attachments

[B=]  Protected images

Z Images shot with the camera's AEB function
¢

Rotated Images (In display only)




53
Display Mode

e Selects the display style for the Browser Area.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

e pame MG pop1 |
Moddes 200812011
il e srm
lmage size 1600 x 1208

(e G 0005

o - SN s gwrrl S e R

List Mode

Displays the images in the folder selected in
the Explorer Panel section in rows and
columns.

s s

w008 4 0007 ¢

e [ || T A A [ e || HHE
o ] = . 8

Cins Comes Vom rage SlinShns P bEnak Sendin Tk
ol Lhsied 1 Tod s
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu
Changes the size of the thumbnailin  Click this to select/deselect all
the Browser Area. images in the Browser Area.

View ‘-f? Fulte.rTuol ‘.H R V e q q || 5e|ecting'|mages “ ‘(-El EI El)
Filter Tool Menu Hide Buttons ————
Displays only images that correspond to the Left: Hidesthe Explorer Paneland
specific conditions. the last downloaded image.

Middle: Hides the control panel.

Right: Hides the Show Shooting
Information panel in the
Preview display mode.

Control Panel
* The control panel contains buttons for executing various functions.

i o = ]

Canon Camera WView Image SlideShow Print & Email Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 58).



Double-click an image in the Browser Area to display it in the Viewer Window.

[ XsXs] B IMG._ 0001 JPG (1/7)

Zoom
Changes the
image zoom
setting.

Star Ratings Menu
Sets the Star Rating

== e B w+ . foranimage.
Image Selector Button
Switches between .
images. Show Information Menu
Displays shooting information.
Save Button !
Saves the edited image. Print Button
Prints the displayed image.

Edit Menu

Full Screen Button

You can edit, eliminating red eyes,
adjusting colors and brightness, cropping
and inputting titles.

You can also use it to start up other
programs for editing.

Number of Displays Menu
Displays multiple images at

Displays the image in the full screen
mode. (You can also double-click an

image to display it in full screen mode).

Click the image or press any key on the
keyboard to restore the normal display
mode.

Synchronize Button
Synchronizes the display settings when multiple
images are displayed.

once. This is handy for
comparing images.

The [Display Original Image] button displays beneath the image. Clicking
this button displays the converted image in the Viewer Window.
*Movie is Displayed

eButtons will appear below the movie, allowing it to be played back or the
sound to be adjusted.

*On some computer systems, you may experience dropped frames leading to
jerky motion or intermittent sound when replaying movies.

eIf you click the [Save as Still Image] button, you can extract still images from
movies. You can also delete unwanted sections at the beginning or end of
movies by clicking the [Cut Movie] button.

Iﬁl *RAW Image is Displayed




56 Using the Software on the Macintosh Platform — Advanced Techniques

File Information Window

The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview

display mode.

Switches between showing and hiding
detailed information for the category.

File Information

Star Rating

Switches between
showing and

hiding detailed
information.

¥ Comment
in Kamakura

Hide Detail )

File Name IMG_0001

PIayS a sou nd 200B/06/12 18:22:41 7‘ Keyword

memo attached File Size 528 KB (537,343 Bytes) (View]wodity Keywords - =
) Image Size 1600 x 1200 I'

to an Image. Data Type: #G v Brightness Histogram

Sound: |

Lock: m
Lock I
Prevents an image
from being -
overwritten or ¥ Shooting Infarmation
deleted.

T item Name Vahue
Fie

image Size  1600x1200
image Qualit Fine

< Back (Next> )

-_—————————

Image Selector Buttons File Name
When multiple images are You can change
selected, you can switch file names.

between images that display
information in the File
Information Window.

Star Rating / My Category
Sets the rating for an
image.

An icon will display if a My
Category is set.

Comment
You can type a comment
here.

Keyword
Sets the keywords used in
searches.

Brightness Histogram

A graph of the highlights
and shadows distribution
in an image.

Shooting Information
Displays detailed
information, such as the
shutter speed and
exposure compensation
setting. The camera model
will determine what
information is displayed.



ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

your model supports them.

Some ImageBrowser functions may not be available with certain camera
models. Check the Specifications section of your Camera User Guide to see if

The following workflow is used in ImageBrowser.

T select a feature from the Control Panel or the menu.

(migelrwurm Edit View Internet Window Help

Check the Help menu for

T — xw procedures and features.
Menu
MNew Folder N
Favorte olders . e
I Y ot
Copy Image...
Move image.. 1]
Duplicate D
Rename... Ak
Send to Trash wa .
Search... xF
Export Image..« . -—
Organize image
Process RAW Images by Digital Photo Professional.. 0006 BC_D003FE SIC D0 I . 50 L
Connect to Camera... g = ——— —
Rewrite Image to Memory Card. Fd 4 a & - 4| EHHE
o = 2
Index Print... Cangea Carmera. Wit Wi Shadeshim i & Ermad Send 10 Trkih
o o LB T
1 o - Index Print — —
——— Layaut Print.
Create Image for Email.

Control Panel

2 Pperform the procedures according to the instructions.

[ X:1:] Phato Print

Printer

KANOOK o}
Page setup

Paper size
s

Click [Pags Setug] to enale

5 printing o
supparted printers.

Shaating Date/Time.

[ Nore ]

Procedural instructions _‘—( e T D

4P| image: 173

copies: [ 1]

Cose ) i)

Total ©  Ipages
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& & = 3

Canon Camera View Image SlideShow Print & Email Send to Trash

Canon Camera
CameraWindow will display if the camera is connected, and you will be able to perform the
following actions.
GH Acquire Images
I=Y Downloads images and sound files from the camera (p. 45) .

M Print
Selects and prints the images in a camera.

G} Write to Camera
=Y Uploads images on the computer to the camera.

@) Set to Camera
3@ Sets the camera owner’'s name.

You can perform the following actions if a memory card reader is connected.

eDownload images from the memory card
Download image or sound files from the memory card (p. 48).
You can also specify images on the memory card for printing.

eUpload images to the memory card
Upload images from the computer to the memory card.

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.
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Print & Email

Photo Print
Prints one image per page (p. 49).
You can print "photos" easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Create Image for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]
e Edit and Save: allows you to change the file type or size and export the file.
eExport Shooting Properties: allows you to export the shooting properties as a text file.
eExport as a Screensaver: Exports the image as a screen saver file.
eExport an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.

eRename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [Process RAW Images by Digital Photo
Professional] (certain models only)

Converts RAW images into JPEG or TIFF images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 65).

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 64).
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Display Settings: [View] menu, [View Settings]
Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]
Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.

ImageBrowser has the following features as well.

[My Camera Settings] (certain models only)
You can set the camera’s settings such as the start-up image or shutter sound (p. 68).

[Remote Shooting] (certain models only)
You can shoot and operate the camera from a computer (p. 61).
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Operating the Shutter Remotely (Remote
Shooting)

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

¢ Ensure that you turn off your computer’s sleep mode before you begin

0 remote shooting. The device performance cannot be guaranteed if the
computer enters the sleep mode.
*RAW images can not be recorded.

Remote Shooting can only be used with camera models listed as compatible
with remote shooting in the Specifications section of the Camera User Guide.

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

Methods for connecting the camera to the computer and placing it in the
correct mode for connecting vary between camera models. Please refer
to the Camera User Guide.

2 |f CameraWindow appears, click [Operate Images on Camera] followed by E3 in the
View Window to close CameraWindow.

CameraWindow —
EHL®

Thumbnail Window View Window
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3 Doublelick the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [RemoteCapture DC] icon.

According to the default settings, recorded images are saved into the
[Pictures] folder. To change the destination, select [Preferences] from the
[RemoteCapture DC] menu.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

6 Click the [Release] button.

uh

or the keyboard's space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.

@ *You can also release the shutter by pressing the camera’s shutter button




Shows/Hides the
viewfinder or
detailed settings
area.
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Size and Resolution Selector
Selects the size and resolution at which

images are captured.

8en8o

RemoteCapture DC

G (aL B

Release

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera’s viewfinder.

(S) Hide ViewFinder
8 Hide shooting details

SR

1 Add comments shown below

~ L NG
- = .

—[ Field angle/flash | Shooting settings w—\‘

Focusing Point: Flash:
H [ off ¥
Macro: FlashQuality:
[off = :
AF-assist light:
. On B:
AF operation:
AF unlock i

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

Set the camera shooting settings here.

Iﬁl The settings available vary between camera models.
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Merging Panoramic Images — PhotoStitch

You can create a wide panoramic image by merging images of a scene shot separately.
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the
size and orientation. You can also manually specify the overlapping areas.

Select a series of images in the ImageBrowser's Browser Area.
Click the [Edit] menu and select eno ————

Ph S H h 1. Gliok [ATTANQE] 10 $64£C1 Ihe Merge direchon when all e images aré 0aded
otoStitch|. g 2. Drag images into the comect pasition lor merging.

A 3. Click [2. Merge]
Instructions —

| STALOS78JPG STD_0581JPG

Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.

Images Shot in Stitch Assist Mode

It is easy to merge images if they are shot with the camera's Stitch
Assist mode because PhotoStitch can automatically detect the image
order and orientation. The series of images are saved together in a
single folder when they are downloaded from the camera.

Symbol displayed by images
shot in Stitch Assist mode.

* Some camera models may not support Stitch Assist mode.

¢ See the Camera User Guide for information about shooting in Stitch Assist mode.

®Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up
lens cannot be merged accurately.
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Processing RAW Images

RAW images contain ‘raw’ data that has not been subjected to any compression processing by
the camera. Since the data is captured in a proprietary format, it cannot be handled or
displayed by standard software programs. You can use Digital Photo Professional to adjust and
convert RAW images into standard JPEG or TIFF images with minimal image quality loss.

*RAW images can only be recorded on models that list RAW as one of the
data types in the Specifications section of the Camera User Guide.

*Only RAW images compatible with Digital Photo Professional can be
converted. Be sure to refer to the Data Type item in the Specification section
of the Camera User Guide.

*The use of Digital Photo Professional is recommended on computers that
satisfy the following system requirements.

CPU: Core 2 Duo or better

*You can download a PDF manual from the Canon website that explains in

detail how to use Digital Photo Professional.

Converting Images

1 clickan image, then select [Process RAW Images by Digital Photo Professional] in
the [File] menu.

2 seclect a RAW image in Digital Photo Professional’s Main Window.
3 click =3 (Edit image window).

Main Window

Selects folders
containing
images.
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4 Adjust the image brightness and white balance in the tool palette.
The modified contents (the information for image processing requirements) are saved

along with the image as a “recipe”.
The items available to be modified differ depending on the camera model

You can adjust all three RGB

channel levels together or

separately with the Tone Curve. Reduces noise that occurs
when shooting night time
scenery, or when shooting
at a high ISO speed.

Y Digital Photo Professionsl - [ Macintosh HD/Lisers XXX Pictures IMG0012.CR2 |

Adjusts the brightness,
white balance and picture
style.

Adjusts the contrast, color
tone, colorsaturation and
sharpness.

With Digital Photo Professional, you can adjust images to achieve the
best results for your desired scene or subject by specifying a picture style.

5 In the [File] menu, select [Convert and save], set the file type and destination and
then click [Save].

Renames the file. a9 Convert and save
I— Save As: | IMG_0013 (&2
Selects the file ————————— where: | = Pictures 3]
destination.
File format
Kind of file Exif-JPEG ‘:l
| Image quality =
Selects the file type. T
Output resolution 350 dpi ¥ Embed ICC profile
Resize setting
Insertacheck mark ————resize
Width Height Unit
here to change the 116 x 3312 ixe
f||e size. (4416 pixel ) (3312 pixel )

W Lock aspect ratio

("Cancel )
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Printing Images

Digital Photo Professional offers the following printing methods.

Single Print (Auto Settings)

After selecting an image in the Main Window, click the [File] menu and select [Print].
With this method you can automatically lay out a single image on a single sheet of paper and
print it.

Single Print (Detailed Setting)

After selecting an image in the Main Window, click the [File] menu and select [Print with
detailed setting].

You can adjust the layout for a single image on a single sheet, and print out such items as an
inserted title and shooting information along with the image.

Inserts text.

MG 0012.00

HOOXXHOOXHHXXNX

HUNKAXKK

Sets the image size and
image layout, and
shooting information.

Contact Sheet

After selecting images in the Main Window, click the [File] menu and select [Contact Sheet
Prints].

With this method, you can print multiple images on a single sheet. You can set the number of
images and the layout and insert text too.

I— Inserts text.
(Comtact Shaat Prints
Prener [ mage| Text | Sertings

Sets the number and order
of images laid out on one
sheet.
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Enjoy Customizing Your Camera with the My
Camera Settings

My Camera functions can are only available with camera models listed as

compatible with My Camera functions in the Specifications section of the
Camera User Guide.

¢ To register the My Camera settings with the camera, ensure that you install
the software that came with the camera.

*Do not break the camera connection by unplugging the interface cable or
switching off the camera power while the My Camera settings are being
added to the camera or being saved to the computer from the camera.

Adding My Camera Settings to the Camera

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. My Camera settings are saved onto your computer when you

install the bundled software. This topic explains how to register the My Camera settings saved
onto your computer with the camera.

T After connecting the supplied interface cable to the computer’s USB port and the
camera’s DIGITAL terminal, turn on the camera power, set it to playback mode and
prepare it to communicate with the computer

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

2 f CameraWindow appears, click [Operate Images on Camera] followed by EJ in
the View Window to close CameraWindow.

CameraWindow

I mEHT®E
| ‘D-A‘|

Transfer Untransferred Images.

e ——

Operate Images on Camera

Thumbnail Window View Window
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3 Doublelick the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.

The My Camera window will display.
4 sclect the type of setting in the Type list box that you wish to save to the camera.

5 sclectthe settings to add and replace.

Settings to add: select from the [Computer] list.
Settings to replace: Select from the [Camera] list.

6 Click the [~ button.

If a setting for this category has previously been saved to the camera, press [OK] and it will
be overwritten.

7 Click the [Save to Camera] button.
Click [OK] to conclude the process of saving the My Camera settings to the camera.

Save to Camera Save to Computer

Type:  Theme %

Computer

121 i' =
321 -
Displays the settings saved ————— o T
to the computer. E:;‘i;wl
CHIMPANZ 1 TR TARERRE
ETHDANCEZ 1
Add {_ Sendto Trash )
( )
[Send to Trash] Button e m
Deletes settings from the
com pu‘ter Save To:Macintosh HD/Users/ XXXXX /Library/Preferences/ImageBrowserUserData/

Exit

8 Changing the My Camera settings with the camera.
See the Camera Users Guide.
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Adding Original Start-Up Images or Sounds

You can add original start-up images or sounds created with image editing and other software
to the My Camera Window. Sound files are saved as WAVE-type files.

1 Double-click the [Applications] folder, followed by the [Canon Utilities] folder,
[CameraWindow] folder and the [MyCamera DC] icon.

The My Camera window will display.

2 sclect the [Start-up Image] in Type.

For sound files, select either [Start-up Sound], [Operation Sound], [Selftimer Sound] or
[Shutter Sound].

3 Click [Add].

CHIMPANZ1_SI01JPG
ETHDANCEZ1_SI01.JPG

i 3
[Add] Button Send to Trash )
Adds images and sound

files for use as settings & & = .\
files in the list.

4 sclect the file you created and click [Open].
This concludes the process for adding new data.

You can add the settings files you just added to the computer to the camera using the
same procedures as in Adding My Camera Settings to the Camera (p. 68).

Use the following settings to create start-up images or start-up sounds
using image editing software or sound processing software.

e Start-Up Images

Image Type : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Resolution (WxH) 1320 x 240 or 512 x 288*

* Varies with camera model

e Start-Up Sounds
Type : WAV (Monaural)
Bit Rate / Frequency : 8 bits (11.025 kHz or 8.000 kHz)

Set the sound file length to values approximating those in the
following chart.

Type Duration in Seconds
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

1 Cclick the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

The uninstall utility will start and remove
ZoomBrowser EX.

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.
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Memory Card Folder Structure

The images on a memory card are placed in subfolders of the [DCIM] folder labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 999.

— IMG_xxxx.JPG (JPEG images)

EI T — _MG_xxxx.JPG (JPEG images recorded in the
DCIM Adobe RGB color space)
xxxCANON —— IMG_xxxx.CR2 (RAW images)
—— _MG_xxxx.CR2 (RAW images recorded in the
Adobe RGB color space)
— STX_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.MQOV, MVI_xxxx.THM* (Movies)
—— MVI_xxxx.AVI, MVI_xxxx.THM* (Movies)
—— SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC
T EI A N SEEhe EI SDR_xxxx.WAV (Files recorded with Sound Recorder)
SNDR xxXCANON

* *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

*The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

o All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.

¢ Depending on the camera, some data types cannot be recorded.



Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section (p. 9)?

? Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.

? Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.

? Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery.
You are recommended to use an AC adapter (sold separately) to power
the camera when it is connected to a computer.

73
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Problems

Try the suggested solutions to the common problems listed below.

Add New Hardware Wizard displays when the camera is connected to
the computer with an interface cable (Windows).

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

Cannot download images or shoot remotely. (For cameras connected to
the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by
following the procedures below.

Solution:

Hold the MENU button on the camera down and press the Cyas (Print/Share)
button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.

V)

Camera not detected, Events dialog won't display or images will not
download to the computer (when camera is connected to the computer
via an interface cable (Windows)).

The camera may have been recognized as another device under the

following circumstances (Windows only).

¢ The [Scanners and Cameras] icon cannot be found in the [Hardware and
Sound] within the [Control Panel] or the [Printers and Other Hardware]
window.

* Your camera model name, [Canon Camera] or a camera icon does not display
when [Scanners and Cameras] icon is clicked.

Solution:
Delete the device with the following procedures.

You must be authorized as a Computer System Administrator to delete
devices.

1. Display the [Device Manager] dialog.
Windows Vista: Click the [Start] menu, [Control Panel], [System and
Maintenance], [System], and Task list [Device Manager].
Windows XP: Click the [Start] menu, [Control Panel], [Performance and
Maintenance], [System], [Hardware] tab, and the [Device Manager] button.



75

2. Click the [#] symbol beside the [Other devices], [Portable Devices] and/or
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories
if it is being recognized as an “other” device.

T Tr— (9=
Fie accon pew Hep Fie Acton Ve Hep
BFé R A =RE BFSd & A xR

3

% @ saund, whso and game contrclere

There are other potential reasons for the problem if the “Other
devices”, “Portable Devices” or “Imaging devices” categories do not
appear or your camera model name or [Canon Camera] does not appear.
Proceed to Step 5, and temporarily quit the procedures.

3. Select your camera model name or [Canon Camera], right-click and select
[Delete].

4. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

5. Close [Device Manager] or [System Properties].
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Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel].
2. Display the [Hardware acceleration] setting window.

Windows Vista: Click [Appearance and Personalization], followed by [Adjust
screen Resolution], [Advanced Settings] button and [Troubleshoot] tab.

Windows XP: Click the [Appearance and Theme] icon, followed by the
[Display] icon, [Settings] tab, [Advanced] button and [Troubleshoot] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

An error message "Insufficient free memory" displays when

using PhotoStitch

Please try one of the following methods.

¢ Close all other applications other than PhotoStitch.
¢ Reduce the size or number of images to combine.
¢ In the [Save] tab, select [Adjust image...], then in “Saved Image Size” reduce the size.



Downloading Images without Installing the
Software

You can download images by simply connecting the camera to a computer, without installing
the software bundled on the Canon Digital Camera Solution Disk.
However, please note that there are several limitations.

Iﬁl If you use the bundled software, the following limitations do not apply.

e [t may take a few minutes, after connecting to the camera, until you can download images.

* The camera information (firmware version, etc.) may not display correctly. In this case, use the
software from the Canon Digital Camera Solution Disk.

¢ Sound files attached to still images as sound memos and sound files recorded with the Sound
Recorder function may not download depending on file size and software used.

*RAW images or JPEG images recorded at the same time as RAW images may not be
downloadable with some software programs or operating systems.

* Movies may not download correctly if the file size or software program is incompatible.

*Images shot in the vertical orientation may be downloaded in the horizontal position.

¢ The protection setting for images protected in the camera may be lost when transferred to
the computer.

e In addition, there may be problems with downloading images or image information correctly
depending upon the version of the operating system in use, the file size or the software in
use.
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